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                  Installation of Apache OpenMeetings 2.x on Debian 7 Wheezy 32 or 64 bits

                             We should use the binary version of OpenMeetings, that is to say 
                             will suppress the compilation.
                             This tutorial is done step by step thinking those who begin.
                             Special thanks to Federico Christian Tomasczik.

                                                                       15-2-2013

1)
Need download Adobe Flash Player:

                                 http://www.adobe.com/support/flashplayer/downloads.html

...clic on:   Get the latest version

...everyone chooses 32 or 64 bits according to his operating system

...and :  Linux tar.gz

Open your Home folder:

/home/your_user_name

and go to:

View => Show Hidden Files

Open the folder:

.mozilla  (atention the point before mozilla)

...and make a new folder called “plugins”. Will look so:

/home/your_user_name/.mozilla/plugins

Uncompress the flash player unloaded, and inside the resultant folder there will be a file 
                                                                                                                                                       
                                                                                                                                                       

http://www.adobe.com/support/flashplayer/downloads.html
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called:  libflashplayer.so ; copy and paste into the newly done plugins folder.

This way we will have installed flash player, need it to OpenMeetings functioning.

Uninstall  the OpenJava plugin that come with Wheezy:

# apt-get remove icedtea-netx icedtea-netx-common

Wheezy have other flash player installed that we should deactivate. Run Iceweasel  browser
and go to:

Tools => Add-ons => Plugins => Shockwave Flash (Shockwave Flash 10.1 r999...)

...to right is a button, clic on it:  Disable

...and this way we remain alone with our flash player unloaded.

2)
We should add these repositories to ours:

# gedit /etc/apt/sources.list

Copy and paste:
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## from here.

deb http://ftp.es.debian.org/debian/ wheezy main
deb-src http://ftp.es.debian.org/debian/ wheezy main
deb http://ftp.es.debian.org/debian/ wheezy contrib non-free

### wheezy-updates, previously known as 'volatile'
deb http://ftp.es.debian.org/debian/ wheezy-updates main contrib
deb-src http://ftp.es.debian.org/debian/ wheezy-updates main contrib

###**Repository multimedia** THIS IS NEED IT
deb http://www.deb-multimedia.org wheezy main non-free

## until here.

...and update:

# apt-get update

# apt-get install deb-multimedia-keyring
                                                                                                                                                      
                                              

                                             --------- Oracle Java Installation---------

2)
Also will add these repositories for Oracle Java only. Though they refer to Ubuntu, they are
valid for Debian 7 Wheezy. It is testead.

# echo "deb http://ppa.launchpad.net/webupd8team/java/ubuntu precise main" | tee -a 
/etc/apt/sources.list

...everything in an alone line with separation

# echo "deb-src http://ppa.launchpad.net/webupd8team/java/ubuntu precise main" | tee -a 
/etc/apt/sources.list

...everything in an alone line with separation

# apt-key adv --keyserver keyserver.ubuntu.com --recv-keys EEA14886

# apt-get update

# apt-get install oracle-java6-installer
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...will ask us if you agree with the license, pulsate ENTER to accept it.

   

...it will turn us to asking it brings over of the license. Move the cursor to position it in YES   and 
pulsate Enter:
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Now should see what options of java we have:

# update-alternatives --config java
                                                                                                                                                       
...type the line number where is (if is):
                                                                                                                                                      
  /usr/lib/jvm/java-6-oracle/jre/bin/java   ….  auto mode
                                                                                                                                                  
...and pulsate Enter.

                                 ---------- OpenOffice or LibreOffice Installation ----------

3)
LibreOffice already it comes installed on Wheezy 32 and 64 bits.
LibreOffice work in the process to convert room uploaded files.

                            ----------  Installation Compile Packages and libraries -----------

4)
# apt-get install imagemagick gdebi libgif4 libjpeg62

Download SWFTOOLS, it should convert files diverse to .swf flash.

For Wheezy 32 bits:
                                                                                                                                                      
                                http://assiste.serpro.gov.br/libs/swftools_0.9.1-1_i386.deb

For Wheezy 64 bits:

                                http://assiste.serpro.gov.br/libs/swftools_0.9.1-1_amd64.deb

(others swftools download olders urls
http://www.anexar.org/download/swftools_0.8.1-2.1_i386.deb   
http://old-releases.ubuntu.com/ubuntu/pool/universe/s/swftools/ )

To install it we do right click on the unloaded file and go to:

                              Open With Gdebi Package Installer

...should ask for root password. It will begin the installation.

                                                                                                                                                       

http://assiste.serpro.gov.br/libs/swftools_0.9.1-1_amd64.deb
http://assiste.serpro.gov.br/libs/swftools_0.9.1-1_i386.deb
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Now  should Compile FFMPEG for video. To install the one that comes in the repositories, we 
would find very possibly problems with the recording video

Our compiled ffmpeg will have characteristics that they do not find in the normal version.

                                                                                                                             
We install everything necessary for the compilation:
                                                                                                                                                      
# mkdir /usr/local/share/ffmpeg

                                                                                                                                                               
# apt-get install libart-2.0-2 libt1-5 zip unzip bzip2 subversion git-core checkinstall yasm texi2html

...everything in an alone line

# apt-get install libfaad-dev libmp3lame-dev libsdl1.2-dev libx11-dev libxfixes-dev libxvidcore4 
libxvidcore4-dev 

….everything in an alone line

# apt-get install zlib1g-dev libogg-dev sox libvorbis0a libvorbis-dev libgsm1 libgsm1-dev libfaad2 
flvtool2 lame

Download ffmpeg and compile:

# cd /opt

# wget http://ffmpeg.org/releases/ffmpeg-1.1.2.tar.gz

# tar zxf ffmpeg-1.1.2.tar.gz

# cd ffmpeg-1.1.2

...what comes now quite in an alone line

# ./configure --enable-libmp3lame --enable-libxvid --enable-libvorbis --enable-libgsm --enable-gpl 
--enable-nonfree

# make    (It takes enough time...patience)

# checkinstall

...should ask three times. Ensware always pulsating  ENTER

A .deb file will be generated and will autoinstall himself. You can save it. Is in: 

      /opt/ffmpeg-1.1.2
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...called:           ffmpeg_1.1.2-1_i386.deb  or  ffmpeg_1.1.2-1_amd64.deb

This alone file will be valid for the operating system and machine in the one that has
been compiled.

Now should block our ffmpeg compiled and installed. For it go to:

        Synaptic → clic on ffmpeg → Packages (is in top left window) → Block version
                                                                                                                                                       
            
We do this in order that in the later updates of the system that we realize our compilation does not 
resign us, and in his place install a new version that though it is more recent will not have the 
properties of that we have compiled.

We delete the folder where we have compiled:

# cd /opt

# rm -R ffmpeg-1.1.2

5)
In the previous step we have installed SOX for audio work.

                                    -------------- MySQL Installation--------------

6)
# apt-get install mysql-server

...ask for a MySQL root password. Type one of your wish, remember it and pulsate key tabulator
and later Enter:
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...and repeat the password:

                                                                                                                                                       
                                                                                                                                                                
We join MySQL and build the OpenMeetings database:

# mysql -p -u root

...ask for MySQL root password. Type it. 

mysql> CREATE DATABASE open2final DEFAULT CHARACTER SET 'utf8';

With this command we have created a so called database open2final though you can choose other 
one to your wish. 
 
Now we create a user with all the permissions for the database that we have just done.

Type this command everything in an alone line with space between both:

mysql> GRANT ALL PRIVILEGES ON open2final.* TO 'openmeetings'@'localhost'
IDENTIFIED BY '123456' WITH GRANT OPTION;

                                       * open2final ...database name we did before
                                       * openmeetings ...database user name
                                       * 123456 ...user name password 

You can change the data, but remember it..

Leave MySQL console:
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mysql> quit

                                  -------- OpenMeetings 2.0 or 2.1 Installation--------

   
7)
I will base on the version 2.0 for the exhibition. The installation of 2.1 is exactly equal
except a little difference. It is the tar.gz format of compression of the file to download.

                                                                                                                                                        
                                  ===== Special beginning for OpenMeetings 2.1 ======

The steps till now given serve also for the version 2.1 for what it is not necessary to repeat them.
Download the 2.1 version if you like to install it:  

                                          https://builds.apache.org/job/openmeetings/

...the file: apache-openmeetings-2.1.0.r1441250-31-01-2013_2314.tar.gz 

...or new version if it is. If so remember change the tar.gz name. 

# mkdir /opt/red5     

# cd /opt/red5  ...copy or move to this path the apache-openmeetings-2.1.0.r1441250-31-01-
2013_2314.tar.gz file and uncompres:

# tar zxf apache-openmeetings-2.1.0.r1441250-31-01-2013_2314.tar.gz

# rm apache-openmeetings-2.1.0.r1441250-31-01-2013_2314.tar.gz

...now you can follow the same steps that I indicate down below from the paragraph 7b)

                                 ====== Special end for OpenMeetings 2.1 ======

Begin with the version 2.0
.

# mkdir /opt/red5

# cd /opt/red5

# wget http://www.apache.org/dyn/closer.cgi/incubator/openmeetings/2.0-incubating/apache-
openmeetings-incubating-2.0.0.r1361497-14-07-2012_1108.zip

https://builds.apache.org/job/openmeetings/
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# unzip apache-openmeetings-incubating-2.0.0.r1361497-14-07-2012_1108.zip

# rm apache-openmeetings-incubating-2.0.0.r1361497-14-07-2012_1108.zip

7b) ...From here it serves for the versions 2.0 and 2.1

Every block of text that comes later, put it in an alone line with separation between both (blue and 
green).
             
# mv /opt/red5/webapps/openmeetings/WEB-INF/classes/META-INF/persistence.xml 
/opt/red5/webapps/openmeetings/WEB-INF/classes/META-INF/persistence.xml-ori

# mv /opt/red5/webapps/openmeetings/WEB-INF/classes/META-INF/mysql_persistence.xml 
/opt/red5/webapps/openmeetings/WEB-INF/classes/META-INF/persistence.xml
                                                                                                                                                      

# gedit /opt/red5/webapps/openmeetings/WEB-INF/classes/META-INF/persistence.xml

...change in the line:

                                     Url=jdbc:mysql://localhost:3306/openmeetings?....

                         openmeetings to open2final  ...this is the database name we did.

Change the follows lines:

                                                         , Username=root
                                                         , Password="/>

...change root to openmeetings ...this is the user database name we did.

...the line:  , Password=123456"/> , type the user database password (123456) we did, if you
don´t type another different.

                                                    ------- Connector MySQL  -------

8)
Download the connector MySQL to OpenMeetings. Can employ any of the follows links:

# cd /opt
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(Universidad Autónoma Metropolitana Mexico)
# wget http://mysql.azc.uam.mx/Downloads/Connector-J/mysql-connector-java-5.1.23.zip

(Swedish University Computer Network)
# wget http://ftp.sunet.se/pub/databases/relational/mysql/Downloads/Connector-J/mysql-connector-
java-5.1.23.zip

# unzip mysql-connector-java-5.1.23.zip   

# cp /opt/mysql-connector-java-5.1.23/mysql-connector-java-5.1.23-bin.jar
/opt/red5/webapps/openmeetings/WEB-INF/lib

...everything in an alone line with separation between both.

.
# rm mysql-connector-java-5.1.23.zip   

# rm -R mysql-connector-java-5.1.23
 
# cd /opt 

# mv red5 /usr/lib

# chown -R nobody /usr/lib/red5

                                                      --------- Jod converter ----------

   
9)
Unload Jod converter. It will help to convert the files that we upload in the room.

# cd /opt

# wget http://jodconverter.googlecode.com/files/jodconverter-core-3.0-beta-4-dist.zip

# unzip jodconverter-core-3.0-beta-4-dist.zip

# rm jodconverter-core-3.0-beta-4-dist.zip

                                         ------- Run Red5-OpenMeetings Script --------

Can download the run red5-OpenMeetings script. The instructions of installation are inside the zip
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Squeeze - Wheezy
https://cwiki.apache.org/confluence/download/attachments/27838216/OpenMeetings+2.x+run+scri
pt+Squeeze.zip?version=1&modificationDate=1360140075000

This script comes prepared to use in this tutorial without modifying his interior. Only to follow the 
indications of installation.

                                                                                                                                               
                                                    --------- Run OpenMeetings ---------

 

11)  
# /etc/init.d/red5 start

...in the shell this text will appear:

                             start-stop-daemon: --start needs --exec or --startas
                             Try 'start-stop-daemon --help' for more information.

...do not be afraid, everything works correctly. Wait a few seconds in order that it begins

Go with browser to:
                                                                                                                                                     
                                             http://localhost:5080/openmeetings/install

...and this page will appear:

...clic on:  Continue with STEP 1

http://localhost:5080/openmeetings/install
https://cwiki.apache.org/confluence/download/attachments/27838216/OpenMeetings+2.x+run+script+Squeeze.zip?version=1&modificationDate=1360140075000
https://cwiki.apache.org/confluence/download/attachments/27838216/OpenMeetings+2.x+run+script+Squeeze.zip?version=1&modificationDate=1360140075000
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…and this other page will appear:

...we introduce necessarily to be able to continue the installation:

:

                                   Username  =  user administrator name (your whish)

                                   Userpass    =  user administrator password

                                   Email        =  your e-mail address

                                   User Time Zone  =   your country or zone 

En Organisation (Domains)

                                   Name         =  group name (your wish)
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...above you can select the language in which OpenMeetings will appear:

                                                   Default Language   =   your idiom

  
...and here below the paths to ffmpeg and jodconverter:
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                                             FFMPEG Path   =    /usr/local/bin

                                            JOD Path           =    /opt/jodconverter-core-3.0-beta-4/lib

...continue in the same page and below completely we touch the button: INSTALL

                                                                                                                                                   
 The formation and writing of the tables of the database begins now. 
Wait somes seconds...without losing the patience, until this page appears:
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                                                    Clic :  Enter the Application

...and access to OpenMeetings login page:

                                                                                                                                                    
Type the user's name and password that you choose during the installation.

Clic on  button Sig in...and you are inside! 

Congratulations!

The next time that acces to OpenMeetings will be:

                                                   http://localhost:5080/openmeetings

     Alvaro Bustos 

http://localhost:5080/openmeetings

